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CATIA V5 Automotive - Body Lesson 7: Create Simple Surfaces



Create Simple Surfaces



Student Notes:



In this lesson, you will be introduced to the functionalities used to create simple surfaces in Generative Shape Design workbench.
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Lesson Contents:



Case Study: Simple surface creation Design Intent Stages in the Process Introduction to Surface Design Organize a Surface Model Create the Reference Geometry Create the Basic Surface Geometry Perform Trim Operations Create Multi-Model Links Duration: Approximately 1 day
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Case Study: Simple Surface Creation



Student Notes:



The case study for this lesson is a simplified inner door used in the Door assembly as shown below.
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The focus of this case study is the creation of wireframe and surface features needed to incorporate a door-mounted stereo speaker.
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Design Intent The model of the simplified inner door must meet the following design intent requirements: The model must be organized in geometrical sets. • Create geometrical sets-’Wireframe’, ‘Sketches’, and ‘Surfaces’.



The speaker opening diameter (A) must be 100mm. • Create a surface by extruding a 2D profile and perform a split.



The depth (B) of all four speaker mountings must be 3mm. • Create a surface by extruding 2D profiles (SpkrMountCrv) and trimming them with another surface (SpkrMountSurf).



The result must be a single surface.



A B
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• Move the final surface to the ‘Result’ geometrical set.
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Stages in the Process Use the following steps to create the model of a simplified inner door: 1.



Organize the model in geometrical sets.



2.



Create a speaker opening curve.



1



2



3 4



3.



Extrude SpkrMountCrvs and trim them with SpkrMountSurs.



4.



Extrude the speaker opening curve and use it to split SpkrMountSurs.



5.



Create a speaker opening. 6



Trim the speaker opening and speaker mount.
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6.



5
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Organizing a Surface Model In this section you will become familiar with the model organizational tools available in CATIA V5.



Use the following steps to create the simplified inner door: 1. Organizing a Surface Model.
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2. Create the Reference Geometry 3. Create the Basic Surface Geometry 4. Perform Trim Operations 5. Create Multi-Model Links
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Introduction to Surface Design



Student Notes:
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In this section, you will learn how to access the Generative Surface Design workbench. You will also become familiar with the tools, terminology, and the general process involved in the creation of a model using surfaces.
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Introduction to Surface Design Wireframe and surface geometry is often needed to define models with complex shapes. Depending on the company rules, surfaces are used in some cases in order to create complex solid shapes. The shape design process will be discussed later, but for now it is important to consider two key points: Wireframe and surface geometry is used to define complex 3D shapes.



B.



Wireframe, surface, and solid geometry can be mixed to form an integrated set of modeling capabilities.
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A.
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Wireframe geometry



Surface geometry



Solid geometry
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Accessing the Surface Design Workbench



Student Notes:
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To access the Generative Surface Design Workbench, Click Start > Shape > Generative Shape Design.
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Surface Design Workbench User Interface (1/4) The Generative Shape Design workbench consists of:



A. B. C. D. E. F.



The specification tree Different types geometrical sets, ordered geometric sets and bodies. Standard Tools toolbar. Workbench icon. Sketcher access Shape design tools



D E



A B



F
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Surface Design Workbench User Interface (2/4)
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The following is a list of tools available from the Wireframe toolbar: A.



Points



O.



Polyline



I



B.



Lines



P.



Projection



C.



Planes



Q.



Combine



D.



Project-Combine



R.



Reflect Line



J K L



E.



Intersection



S.



Parallel Curve



F.



Offset 2D3D



T.



3D Curve Offset



G.



Circle-Conic



U.



Circle



H.



Curves



V.



Corner



I.



Point



W.



Connect Curve



J.



Point and Planes Repetition



X.



Conic



K.



Extremum



Y.



Spline



L.



Extremum Polar



Z.



Helix



M.



Line



AA.



Spiral



N.



Axis



BB.



Spine
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Surface Design Workbench User Interface (3/4) The following is a list of tools available from the Surface toolbar: A.



Extrude-Revolution



H.



Revolve



B.



OffsetVar



I.



Sphere



C.



Sweeps



J.



Cylinder



D.



Fill



K.



Offset



E.



Multi-sections Surface



L.



Variable Offset



F.



Blend



M.



Rough Offset



G.



Extrude



N.



Swept Surface



O.



Adaptive Sweep



G H N O



I J



A B C D



E



F
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Surface Design Workbench User Interface (4/4)
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The following is a list of tools available from the Operations toolbar: A.



Join-Healing



P.



Multiple Edge Extract



B.



Trim-Split



Q.



Shape Fillet



C.



Extracts



R.



Edge Fillet



D.



Fillets



S.



Variable Radius Fillet



E.



Transformations



T.



Chordal Fillet



F.



Extrapolate



U.



Styling Fillet



G.



Join



V.



Face-Face Fillet



H.



Healing



W.



Tritangent Fillet



I.



Curve Smooth



X.



Translate



J.



Untrim Surface or Curve



Y.



Rotate



K.



Disassemble



Z.



Symmetry



L.



Split



A1.



Scaling



M.



Trim



B1



Affinity



N.



Boundary



O.



Extract
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C1



Axis To Axis



Q R



V



X Y Z A1 B1



W



C1



G



S



H I J K



T U



A B C D



L M



E



F



N O P
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Surface Design Workbench Terminology A.



A Part is a combination of a PartBody and geometrical sets.



B.



A PartBody contains the features used to create a solid. It can also contain surface and wireframe elements. A Geometrical Set contains surface and wireframe elements. The order of creation is not taken into account.



D.



An Ordered Geometric Set (OGS) contains surface and wireframe elements. The elements in this body are created in a linear manner. OGS can also contain bodies. Bodies allow creation of solids within an OGS.



A



B



D C
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C.



Student Notes:
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Surface Design Workbench General Process Use the following general steps while creating a surface-based feature: 1. 2. 3. 4. 5. 6. 7.



1



2



Access the Generative Surface Design workbench. Create the wireframe geometry. Create the surface geometry. Trim and join the body surfaces. Access the Part Design workbench. Create a PartBody. Modify the geometry as needed.



3



4 7



5
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Create the Reference Geometry In this section you will learn how to create the wireframe geometry that the model will be built upon.



Use the following steps to create the simplified inner door: 1.



2. 3.



Create the Reference Geometry



Create the Basic Surface Geometry Perform Trim Operations Create Multi-Model Links
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4. 5.



Organizing a Surface Model.
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Model Organization



Student Notes:



As you begin to build complex geometries it is important to manage your model efficiently. A good, structured model with logical grouping of geometries gives a better understanding of the design process. An organized model has the following advantages: A.



B.
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C. D.



All related geometries are clubbed together in groups or sets (like files stored in a folder on your computer directory). This helps the designers to easily interpret the steps carried to design the model. They help to reduce the size of the Specification tree and organize it when it becomes too complex. It is easier to reorder and replace features Problem solving becomes easier as the root cause of the problem can be easily identified.
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Geometrical Sets A Geometrical Set (GS) is the default container for wireframe and surfaces elements. In a geometrical set, the features are not displayed according to the update logical order. It just “contains” features. A.



B. C.



D
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D.



In a GS, you can put any surfacic element you wish and it need not be in a structured logical way. The order of these elements is not important as their access and their visualization is managed independently without any rule. In a GS, a child feature can exist or can be reordered before the parent feature. A GS enables you to gather various features in a same set or sub-set(s) and to organize the specification tree. Multiple Geometrical Sets can be added to a model to contain a genre of the surfacic elements. For example, one GS can be dedicated to contain only wireframes while the other can contain surfaces.



Copyright DASSAULT SYSTEMES



7-17



CATIA V5 Automotive - Body Lesson 7: Create Simple Surfaces Student Notes:



Insert a Geometrical Set Use the following steps to insert a Geometrical Set: 1. 2.



3. 4.



5.



From the Insert menu, select Geometrical Set. The Insert Geometrical Set dialog box is displayed. Select the elements from the specification tree to be contained in the new Geometrical Set. Enter the name of the new Geometrical Set. Use the Father drop-down list to choose the body where the new geometrical set is to be inserted. Click OK to insert the Geometrical Set.



1



2



3
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4
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Move Elements of a Geometrical Set Use the following steps to move elements of a Geometrical Set: 1. 2.



3.



4. 5.



Select the elements to be moved from the specification tree. From the contextual menu, click Selected objects > Change Geometrical Set. The Change geometrical set dialog box is displayed. Select the Destination body as GeometricalSet.1. Select the Point.2 as element before which the selection is to be inserted. Click OK.



1



2



3 4
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Ordered Geometrical Sets



Student Notes:



An Ordered Geometrical Set (OGS) adds the functionality of a linear update sequence to the geometrical set. This allows the ordered geometrical set to have the following additional functionalities: • Features can be scanned (using Edit > Scan or Define In Work Object) allowing you to see the way the features were created • Geometry that is consumed by a downstream feature (e.g. a surface that is trimmed) is not shown. • You can reorder elements. • Graphical properties for new elements are inherited from the parent elements.
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In order to use an OGS, it must be manually added to the model by clicking Insert > Ordered Geometrical Set.
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Create Groups (1/2) A group is a visualization element applied on the Geometrical Sets. When a Geometrical Set becomes too complex or too long to manage, it’s contents can be bundled into a single set called ‘Group’. The group hides all the nodes of the Geometrical Set (in the specification tree) except for specific nodes which the user wants to view. Nodes chosen by user, which are excluded from the Group and can be seen in specification tree
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This helps the user to organize and simplify the specification tree while working with huge models.
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Create Groups (2/2) Use the following steps to create Groups: 1.



2. 3.



4.



Select the Geometrical Set.1. Right-click to get the contextual menu and select Create Group. Rename the group if required. Select Extrude.1, Extrude.2, Extrude.3 and Extrude.4 as Inputs. These elements are excluded from the group and can be seen in the specification tree. Click OK to create a group.



1



2
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3
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Wireframe Geometry Recommendations



Student Notes:
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Note the following points while working with Geometrical Sets: 1.



Elements in this set can be shuffled irrespective of their sequence of creation.



2.



The parent element in this set is not absorbed after any operation. Hence an element can be used and reused at different levels.



3.



Features in the Geometrical Set cannot be set as “in work object”.



4.



Geometrical Sets maintain better flexibility.



5.



Two or more Geometrical Sets can be grouped to form a “Grouped Geometrical Set”.



6.



All related geometries can be clubbed together in dedicated Geometrical Set. This helps the designers to easily interpret the steps carried to design the model.
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Create the Reference Geometry



Student Notes:
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In this section, you will learn how to create the wireframe geometry that the model will be built upon.



Copyright DASSAULT SYSTEMES



7-24



CATIA V5 Automotive - Body Lesson 7: Create Simple Surfaces



What is a Reference Geometry?



Student Notes:



Reference geometries are the basic elements, which provide a stable support to your geometry. As the design matures, the designer can use these initial reference elements to design more intricate wireframe and surface geometries. A reference geometry can be used to limit and control the overall size of the part. Reference elements can be renamed based on its functionality in the model, thus helping you to identify and reuse it at any stage of the design process.
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It is important to rename the Reference elements in order build better understandability in the model during concurrent engineering.
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Creating Reference Geometry (1/3)



Student Notes:



As in the Part Design workbench, Points, Lines, and Planes can be defined from the Reference Elements toolbar.
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For more possibilities and more wireframe geometry, Wireframe Toolbar from Generative Shape Design workbench can be used.
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Creating Reference Geometry (2/3) The following table is a summary of the point creation options.



Type



Geometry



Description Create a point by specifying references based on the selected type.



Points and Planes Repetition



Create multiple points along a curve, line, or edge. In the example shown, five points are created at equal distance on a spline.



Extremum



Creates points, edges, or faces that represent the minimum or maximum locations along a curve, surface or pad feature. In the example shown, the point represents maximum location along the surface edge in the direction of the plane shown.



Polar Extremum



Creates an element that represents the minimum or maximum radius or angle to a reference of a contour. In the example, the a minimum radius point is created on the arc, using the plane as the support and the sketch origin and H axis for direction.
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Point
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Creating Reference Geometry (3/3) The following table is a summary of the line creation options:



Type



Geometry



Description Create a line by entering references based on the selected type. In the example shown, a line is created between two existing points.



Axis



Create an axis through existing circular elements.



Polyline



Create a single element consisting of multiple line segments.
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Line
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Curve Creation (1/2) We can use basic wire-frame elements to create simple and stable reference geometry. More advanced curves are required to define more complex shapes. Curves can be used as guides, limits, or references to create other geometric elements. Curves can be created from points, other curves, or surfaces:



A



For example: A spline is a curve passing through selected points.



B.



An Intersection is created by intersecting two existing elements, such as two surfaces.



B
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A.
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Curve Creation (2/2)



Student Notes:
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The Wireframe Toolbar from the Generative Shape Design workbench can be used to create various types of curves.
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Importance of a Continuous Curve Whenever you create any surface, it derives many of its characteristics from the wireframe used to generate it. When a house is built, the foundation is a very important element in determining the quality of the resulting structure. In surface design, the wireframe should be considered as the foundation of the design. Hence great care should be taken while constructing the wireframe, both inside and outside the sketcher.
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Surfaces inherit the flaws of the parent curve. In a product development cycle, this surface would be further used in downstream operations such as prototyping, machining, tooling, etc, thus affecting the final product.



Curve with small flaw used to make a surface
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Curve will always transmit flaw to surface
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Creating Curves (1/3) The following table provides a summary of the types of curves that can be created by intersecting or projecting existing elements.



Type



Geometry



Description Create a curve by projecting an existing element onto a plane or surface.



Reflect Line Curve



Create a curve defined by the point locations of all surface normals at a specified angle.



Intersection Curve



Create a curve defined by the intersection of existing elements.



Parallel Curve



Create a curve that is parallel to an existing curve at a specified offset distance.
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Projection Curve



Copyright DASSAULT SYSTEMES



7-32



CATIA V5 Automotive - Body Lesson 7: Create Simple Surfaces Student Notes:



Creating Curves (2/3) The following table provides a summary of the types of circles and conics that can be created in the Generate Shape Design workbench.



Type



Geometry



Description Create a complete or partial circle by defining parameters such as center, radius, and tangency.



Corner



Create a rounded corner of a specified radius between two elements.



Connect Curve



Create a curve that will connect two existing elements.



Conic



Create a conic curve of the type parabola, hyperbola or ellipse.
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Circle



Copyright DASSAULT SYSTEMES



7-33



CATIA V5 Automotive - Body Lesson 7: Create Simple Surfaces Student Notes:



Creating Curves (3/3) The following table provides a summary of the types of curves that can be created in the Generate Shape Design workbench.



Type



Geometry



Description Create a curve passing through points on which you can impose tangency conditions.



Helix



Create a helical curve oriented by an axis.



Spiral



Create a spiral curve defined on a support.
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Spline
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Exercise: Complex Wireframe Creation



Student Notes:



Recap Exercise 20 min



In this exercise, you will open an existing model of a Flashlight and use the tools learnt in the lesson to create wireframe geometry for its shell. To save time, simple wireframe elements have already been created for you. Detailed instruction for this exercise is provided for all new topics. By the end of this exercise you will be able to: Create a Polyline Create a Line Create a Spline
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Create a Projection Create a Circle Create a Helix
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Do it Yourself (1/10) 1.



Load Ex7A.CATPart. • Load Ex7A.CATPart. This part already has some points and sketches created for you. a.



b.



2.
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c. d. e.



2c



Notice that all the wireframe elements have been created in a separate geometrical set. Ensure that the Wireframe geometrical set is active.



Create a polyline. • Create a polyline through four existing points. This polyline, along with the spline and the line that you will create in the subsequent steps will be used as the profile for creating a revolve in a later exercise. a. b.



2a



2d 2e



Select the Polyline icon. Select Point.1, Point.2, Point.3 and Point.4 in order. Highlight on Point.2 in the Polyline definition dialog box. Enter a radius of [30mm]. Click OK to complete the polyline.



Copyright DASSAULT SYSTEMES



7-36



CATIA V5 Automotive - Body Lesson 7: Create Simple Surfaces Student Notes:



Do it Yourself (2/10) 3.



Create a line. • Create a line between points. a. b. c. d.



3a 3b



Select the Line icon. Select Point-Point as the line type. Select Point.5 and Point.6 Click OK to complete the line.
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3d
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Do it Yourself (3/10) 4.



Create a spline. • Create a spline to connect the polyline and the line. a. b. c. d.



e. f.



4e



Select the Spline icon. Select Point.4, Point.7, Point.5 in order. Select Line.1 to make Point.5 tangent to it. Ensure that the arrow is pointing in the correct direction. (If needed, click on the arrow to change its direction.) Select Point.4 from the Spline Definition dialog box. Select Polyline.1 to make the spine tangent to the polyline at Point.4. Click OK to create the spline.
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g.



4a
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4g 4c



4f



7-38



CATIA V5 Automotive - Body Lesson 7: Create Simple Surfaces Student Notes:



Do it Yourself (4/10) 5.



Create a point. • Create a point by coordinates. a. b. c. d.



Select the Point icon. Select Coordinates from the Point type menu. Enter X [130mm], Y[0], Z[0]. Click OK to complete.



5a



5b 5c
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5d
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Do it Yourself (5/10) 6.



Create a projection. • Project the point created in the last step onto the guide curve. The point will be used in the creation of a circle. a. b. c. d. e. f.



Select the Projection icon. Select Along a Direction from the Projection type menu. Select the point as the object to project. Select Second Sweep Guide curve as the support. Select the XY plane as the direction. Click OK to complete the projection.



6a 6b



6f
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6c
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6e



6d
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Do it Yourself (6/10) 7.



Create two points. • Create two more points by coordinates. These points will act as endpoints for a circle. a. b.



8.
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c. d. e. f. g.



7b



Create the first point by coordinates. Enter X[130mm], Y[65mm], Z[-55mm] Create the second point by coordinates. Enter X[130mm], Y[65mm], Z[-55mm]



Create a circle. • Create a partial circle through the three points. a. b.



7a



Select the Circle icon. Select Three points from the Circle type menu. Select one of the endpoints. Select the projection point. Select the other endpoint. Set the Circle Limitation to Trimmed Circle. Click OK to complete.
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8b



8a



8f



8g



8c



8d



8e
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Do it Yourself (7/10) 9.



Create a line. • Create a line, this line is used as the axis for a helix feature. a. b. c.



d. e. f.



Select the Line icon. Select Point-Direction from the Line type pull-down. Right-click in the Point field and select Create Point from the contextual menu. Create a point by Coordinates. Select in the Reference Point field and select Point.4. Enter the coordinates •



g.



9a



9b 9c



X = 0, Y = 0, Z = 80



Click OK.
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9f
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9d 9e 9g
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Do it Yourself (8/10) 9.



Create a line (continued). h. i.



Right-click in the Direction field and click X-axis from the contextual menu. Click OK to create the line. The length of the line is not important.



9h



9i
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10. Create a point. • Create a point, this point will act as the start point for a helix. a.



10a



Create a point by coordinates X[120mm], Y[0], Z[75mm].
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Do it Yourself (9/10) 11. Create a helix. • Create a helix. This helix is used as a guide curve in a later exercise. a. b. c. d. e. f. g. h.



Select the Helix icon. Select the point created in the last step as the starting point. Select the Line.2 as the axis. Enter [45mm] as the pitch. Enter [145mm] as the height. Enter [-45 deg] as the start angle. Enter [2.5 deg] as the taper angle. Click OK to complete.



11c



11b



11d
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11e
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11f 11g



11h
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Do it Yourself (10/10) 12. Create a positioned sketch. • Create a positioned sketch. This sketch will be used as a profile for a swept surface in a later exercise. a.



b.



12



Create the circular sketch, as shown, using the ZX plane as the sketch support. Make the center point of the circle coincident with the helix curve.
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13. Close the file without saving it.
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Exercise Recap: Complex Wireframe Creation



Student Notes:



Create a polyline Create a line Create a spline Create a point Create a projection Create a circle
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Create a helix
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The wireframe created in this exercise could be used to create respective surface features, as shown above. You will learn how to create surface features in the next steps.
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Exercise: Complex Wireframe Creation



Student Notes:



Recap Exercise 20 min



In this exercise, you will open an existing model and use the tools learned in this lesson to create the wireframe geometry for a mobile phone. Two guide curves and a sketch have already been created for you. You will use points and curves to complete the wireframe geometry. High-level instructions for this exercise are provided. By the end of this exercise you will be able to: Create Points Create Splines Create Projections
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Create Circles
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Do it Yourself (1/4) 1. Load Ex7B.CATPart. • Load Ex7B.CATPart. Observe that two curves and a sketch have already been created for you.



1



a. Ensure that the Wireframe Geometrical Set is active.



2. Create points. • Create points. These points are used to construct a spline.
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a. Create points at the following given coordinates: Point 1: X = 0mm, Y = 0mm, Z = 9mm Point 2: X = 40mm, Y = 0mm, Z = 7.5mm Point 3: X = 60mm, Y = 0mm, Z = 6mm Point 4: X = 80mm, Y = 0mm, Z = 5.8mm Point 5: X = 90mm, Y = 0mm, Z = 5.8mm
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Do it Yourself (2/4) 3.



Create a spline. • Create a spline through the points. Apply tangency with respect to YZ plane at both ends of the spline.



4.



Create a projection. • Create a projection of Guide Curve 2. a. b. c. d.



Click the Projection icon. Select Guide Curve 2. Select the ZX plane as the support. Click OK to create the projection.



4a
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4d
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4c



4b
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Do it Yourself (3/4) 5.



Create a point. Create a point to be used as a center point for a circle. a.



Create a point by coordinates at:



5a



X = 70, Y = 0, Z = 0



6.



Create a part arc. • Using the Circle tool, create a part arc. a. b. c.
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d. e. f. g. h.



Click the Circle icon. Select Center and Radius from the Circle type menu. Select the point created in the last step as the circle center. The XY plane as the circle support. Enter a radius of [70mm]. Select Part Arc. Start the arc at [135 deg] and end the arc at [180deg]. Click OK to create the circle.
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6c 6d



6f



6b 6g



6h
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Do it Yourself (4/4) 7.



Create a point. • Create another point to locate another circle center at the following co-ordinates X = 20, Y = 0, Z = 0



8.



Create a part arc. • Using the Circle tool, create a part arc as shown.



9.



Close the file without saving it.
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7
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8
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Exercise Recap: Complex Wireframe Creation



Student Notes:



Create a point Create a spline Create a projection
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Create a circle
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Exercise: Complex Wireframe Creation



Student Notes:



Recap Exercise 20 min



In this exercise, you will practice the tools learned in this lesson to create the wireframe geometry necessary for the shell of a Cradle. You will be creating the guide curves connecting the vertices of two given sections using the Spline tool. Later, you will create the same guide curves using the Connect curve tool. This is to understand the difference between the two tools. To save time, simple wireframe elements have already been created for you. Detailed instructions for this exercise are provided for all new topics. By the end of this exercise you will be able to: Create a Line Create a Spline Copyright DASSAULT SYSTEMES



Create a Connect curve
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Do it Yourself (1/5) 1.



Load Ex7C.CATPart. • Load Ex7C.CATPart. This part already has some wireframes and planes. a. Observe that all the wireframe elements have been created in a separate Geometrical Set. b. Ensure the ‘Curves’ Geometrical Set is active.
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2.



Create lines. • Create lines of 20mm length normal to the sections at the vertices as shown. a. Click the Line icon. b. Select Line Type as Point-Direction. c. Select point as Vertex of a Curve.1. d. Select direction as Plane.1. e. Enter [20mm] as end. f. Click OK to complete the line definition. g. In a same way, create lines at all 20 vertices of Curve.1 and Curve2.
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2b 2c 2d



2e



2f
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Do it Yourself (2/5) 3.



Create Splines. • Create splines to connect two corresponding vertices on the both the sections. The steps to create a spline is shown below. You will create other set of splines accordingly. a. b. c.



d. e. f.
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g.



Click the Spline icon. Select the start point of Line.1. Select Plane.1 to make the spline tangent to it. Ensure that the arrow is pointing in the correct direction. If it is not, click on the arrow to change its direction. Select the start point of the corresponding line on the other section. Select plane.2 to make the spline tangent to it. Click OK to create the spline.



3a 3f 3e



3c



3b



Similarly connect all the vertices of the first section with the corresponding vertices of the second section.



Observation: Spline can be created between two or more points. You can imply the tangency at each point using the common vector direction at each point.



Copyright DASSAULT SYSTEMES



3f
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Do it Yourself (3/5) 4.



Hide the splines created in the previous step.



5.



Create Connect curves • Create a Connect curve between two corresponding vertices of the two sections. This is to compare the creation of the 3D curves using Spline and Connect curve tools. a. b. c.



5a



Click the Connect curve icon. Select the start point of the first line as point input. Select Line .1 as a curve.
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5c
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5b
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Do it Yourself (4/5) 5.



Create a Connect curve (continued) d.



e. a.



g.



Select the start point of the corresponding line on the second section. Select the same line as a curve. Ensure that the arrow is pointing in the correct direction. If it is not, click on the arrow to change its direction. Select OK to create a connect curve.



5d



5e
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5g



Observation: Connect curve can be created between two points only. You can imply the tangency at each point using the corresponding curve on which the point lies.
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Do it Yourself (5/5) 6.



Study and note the difference between the Spline curve and Connect curve.



Vertices connected using Connect curves
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Vertices connected using Spline curves
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Exercise Recap: Complex Wireframe Creation



Student Notes:



Create a Line Create a Spline
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Create a Connect curve
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The wireframe created in this exercise could be used to create a surface feature, as shown above. You will learn how to create surface features in the subsequent steps .
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Create the Basic Surface Geometry In this section you will learn some to the common tools used to create surface geometry.



Use the following steps to create the simplified inner door: 1. 2.



3.



Create the Basic Surface Geometry



Perform Trim Operations Create Multi-Model Links
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4. 5.



Organizing a Surface Model. Create the Reference Geometry
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Why Create Surface Geometry? For certain designs, the geometry cannot be completely defined using the tools in the Part Design workbench. Complex 3D shapes often need to be defined using surface geometry which is created based on explicit wireframe construction geometry. Surface geometry can then be integrated into the final solid part definition.
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While creating surface geometry keep in mind the following key points: A.



Surface geometry can describe a more complex 3D shape.



B.



A surface element describes shape, therefore it has no thickness.



C.



Surface geometry can be completely integrated into the solid part so that modifications to the surface are reflected in the solid.



D.



Surfaces should be created oversized so that they can be re-limited to the correct size, rather than initially constructed too small in which case it is more difficult to increase the size. It is easier to Split/Trim surfaces than Extrapolate.



Copyright DASSAULT SYSTEMES



Surface geometry



Solid geometry



7-61



CATIA V5 Automotive - Body Lesson 7: Create Simple Surfaces Student Notes:



Creating an Extruded Surface An extruded surface is created by extruding profiles in a specified direction.



1 2



Use the following steps to create an extruded surface: 1. 2. 3.



3



4



5
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4. 5.



Select the Extrude icon. Select the profile to extrude. Specify the direction to extrude. The direction can be specified using a line, plane, or edge. Direction can also be defined by right mouse clicking on the direction field. In this example, direction is specified using an existing line. Specify limits. Click OK to generate the feature.
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Creating a Surface of Revolution A revolve feature is created by revolving a profile about an axis.



1



Use the following steps to create a revolve feature: 1. 2. 3. 4. 5.



Select the Revolve icon. Select the profile to revolve. Select the axis of revolution. In this example, a predefined line is selected. Enter the angle limits. Click OK to generate the feature.



2 3
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4
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5
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Creating a Sphere (1/2)



Student Notes:



A sphere feature is a full or partial spherical surface. Both complete and partial sphere required center point and radius value. Partial spheres require additional inputs to control the start and end angles for both the parallel and meridian curves. Parallel curves can have an angle between –90 degrees and 90 degrees.
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Meriden curves can have an angle between –360 degrees and 360 degrees.
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Creating a Sphere (2/2) Use the following steps to create a spherical surface: 1. 2. 3.



4. 5. 6.



7.



Select the Sphere icon. Select a point. The sphere will be created about this point. Select an axis system. This axis system determines the orientations of the meridian and parallel curves. If no axis system exists in the model, the default axis system for the model is used. Enter radius of the sphere. Select the sphere limitations. Full or Partial spheres can be generated. For a partial sphere, enter the start and end angles for both the parallel and meridian curves. Click OK to generate the feature.



1



4 5 6 7
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Creating a Cylinder Surface A cylinder surface extrudes a circular profile in a specified direction. Use the following steps to create a cylinder surface:



1



1. Select the Cylinder icon. 2. Select a point. This point acts as the center point for the circular profile that is to be extruded. 3. Select the cylinder axis direction. In this example the Z axis is selected from the contextual menu. 4. Specify the radius of the cylinder. 5. Specify the length. 6. Click OK to generate the feature.



2



3 4
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5
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Perform Trim Operations In this section you will learn how to manipulate the surface geometry to create the final surface model.



Use the following steps to create the simplified inner door: 1. 2. 3.



4.



Perform Trim Operations



Create Multi-Model Links
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5.



Organizing a Surface Model. Create the Reference Geometry Create the Basic Surface Geometry
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Why Are Operations on Geometry Needed?



Student Notes:



After the basic surface geometry is created, it may be composed of construction elements that do not describe the finished shape. Operations such as trim are then performed to produce the required geometry.



While performing the operations, keep in mind the following key points: Operations are used to produce a finished geometry shape.



B.



Elements involved in an operation are kept in the history of the operation, but are hidden.
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A.
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Splitting Elements - Introduction Use the Split tool to remove unwanted portions of the wireframe and surface elements.



Element to be cut



A



You can split: Wireframe elements. Wireframe elements can be split by points, other wireframe elements, or surfaces



-



Surfaces. Surfaces can be split by wireframe elements, or other surfaces.
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-
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Cutting elements



Cutting elements



B



Element to be cut
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Splitting Elements (1/4) Use the following steps to split an element: 1. 2. 3.



Click the Split icon. Select the element to cut. If necessary: a. b. c.



4. 5.



1



Select additional elements to cut by clicking the bag icon. Select the additional elements. Click the Close button to close the Elements to cut dialog box.



3a 4



Select inside the Cutting elements window. Select the cutting element(s).



5 Copyright DASSAULT SYSTEMES



3b
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3b



3c 5
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Splitting Elements (2/4) Use the following steps to split an element (continued): 6. Specify options. a. The keep both sides option lets you keep both sides of the element to be cut. If the option is selected, the result is two split features. This option is only available if one cutting element is selected. b. Select the Intersections computation option to create an intersect feature between the cut element and the cutting element(s). c. Clear the Automatic extrapolation option if you do not want to automatically extrapolate the cutting element so that the operation can be processed.



6a 6b
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6c
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Splitting Elements (3/4) Use the following steps to split an element (continued): 7.



8. 9.



To change the side of the cutting element to be kept, select the cutting element in the list and select the Other side button. Click OK to confirm the split operation. Observe that because two elements were cut, two split features are added to the specification tree.



7
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8



9
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Splitting Elements (4/4) Cutting elements that consist of closed loop curves require additional inputs to precisely define the side of the cut to keep. A.



Without selecting a support, the system cannot fully define the cutting area.



B.



When a support plane is selected, the system can determine the normal vector to the support plane (Vn). A second vector that is tangent to the cutting element is then calculated (Vt). The area to be kept is determined by the vector product (V) of the vector normal (Vn) and vector tangent (Vt). This vector is calculated at each point about the cutting curve.



A



B



Support
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Vt
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Vn V



Vn V



Vt
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Trimming Elements - Introduction



Student Notes:



The Trim tool is used to trim two or more intersecting elements and keep only a part of these elements.



A



You can trim: A.



Two or more wireframe elements



B.



Two or more surfaces.
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B
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Trimming Elements (1/2) Use the following steps to trim the elements: 1. 2. 3.



4.



Click the Trim icon. Select the Standard mode. Select the elements to be trimmed. Select the elements on the portion you want to keep. If required, change the side to be kept by clicking the Other side/next element buttons.



1 2



4
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Trimming Elements (2/2) Use the following steps to trim elements (continued): 5.



6. 7.



Check Intersection computation to create an intersection while performing a trim. Check Automatic extrapolation to extrapolate the elements to trim. Click OK to perform the trim operation. The trim element is added to the specification tree.



5



6
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Replacing Elements (1/2) You can substitute one element in the specification tree with another element using the ‘Replace’ command in the contextual menu. Use the following steps to replace the geometry: 1. 2.



Right-click the element to be replaced. From the contextual menu, select Replace command.



2



Curve to be replaced
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1
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Replacing Elements (2/2) Use the following step to replace the geometry (Continued): 3. 4.



The Replace dialog box opens. Select the replacing element. Click OK to perform the replacement.



Replacing Element



3
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Create Multi-Model Links In this section you will learn how to create multimodel links.



Use the following steps to create the simplified inner door: 1. 2. 3. 4.



Create Multi-Model Links
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5.



Organizing a Surface Model. Create the Reference Geometry Create the Basic Surface Geometry Perform Trim Operations
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What Are Multi-Model Links? (1/3) Using multiple bodies while designing can give the model added flexibility. Boolean operations allow complex models to be created by adding, removing, or intersecting simple geometric shapes.
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Geometry can be shared between models to quickly replicate features in a number of parts. However, in order to share geometry, it is recommended that the elements must be published. In this case the shared geometry can be restricted to published elements only.
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Published geometry is shared to replicate the features.
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What Are Multi-Model Links? (2/3) In the context of the concurrent engineering, Multi-Model Links enable you to design a model using elements from another model.



1



Using Multi-Model Links you can copy bodies created in different files into your own part. This enables to automatically update the part when changes occur in the source files. For example, 1. 2. 3.



Part A is created by Designer A. Part B is created by Designer B. Using Multi-Model links, Part B is copied into Part A.



2
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What Are Multi-Model Links? (3/3) For example (continued): 4. 5. 6.



Using a Boolean operation, Part B is added to Part A. Part B is modified by Designer B. Because of the Multi-model link, Part A is automatically updated to reflect the changes in Part B.



4



5
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Establishing Multi-Model Links (1/3) Use the following steps to establish a MultiModel link: 1. 2. 3. 4. 5.



Source 3



Open both the source and target files. From the source model, right-click on the feature to be copied. From the contextual menu click Copy. From the target model, right-click on the Part as shown. Click Paste Special from the contextual menu.
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Target
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5
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Establishing Multi-Model Links (2/3) Use the following steps to establish a MultiModel link (continued): 6. 7. 8. 9.



From the Paste Special dialog box select As Result with Link. Click OK. The Source PartBody is copied into the target model. Complete the model.



6



7
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Establishing Multi-Model Links (3/3) Use the following steps to establish a MultiModel link (continued): 10. If required, make changes to the source model. In this example, several features have been added to the source body. 11. Update the target model. The model updates to reflect the changes.



10
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Paste Special (1/3)



Student Notes:



Many features can be reused in other documents. This reduces the need to recreate features that are commonly used in files and also aids in concurrent engineering. Several paste special options are available, choose the option that best meets the requirements of your design:
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A.



The As specified in Part document option copies the element(s) with their design specifications. Each feature is recreated in the target model and can be edited. There is no link to the source model. In this example, the ‘Construction Elements’ Geometrical Set from the source document is copied into the Target model. A second set is added to the model containing all the copied elements and their design specifications.
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Paste Special (2/3) B.



Student Notes:



The As Result option copies the elements without their design specifications and link. This option is useful when you do not want to show the feature information or make changes to the copied elements in the target document.
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In the example, when the ‘Construction Element’ Geometrical Set is copied from the Source model and pasted in the Target model it creates datum surfaces. The red lightening bolt against the elements denote that the link has been isolated.
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Paste Special (3/3) The As Result with Link option can be used for copying the individual features and not on the entire Geometrical set. It copies the element(s) without their design specifications and links the copied element(s) to the original object(s). When changes occur in the source document they will update in the target document. Notice that when the surface in the target model is copied using this option, it creates a single surface with a green dot, indicating that there is a link between the source and target documents.
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C.



Student Notes:
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Managing Multi-Model Links (1/4)



Student Notes:



When you use the Paste Special option As result with Link you create a link between the source document and the target document. Copied links display a number of symbols depending on their status:



Icon



Icon (working with Publications)



Description The pointed element is loaded and synchronized The pointed document is not loaded
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Link has been isolated. This icon will also appear if the source document has been copied using the As Result paste special option.
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Source document has been modified. Target document is not up to date. Source document is not found.
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Managing Multi-Model Links (2/4)



Student Notes:



Using the Link Panel, you can determine which document the model points. To access the links dialog box click Edit > Links. The links document lists all links referenced by the correct document and their status.
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Use the links dialog box to Load, Synchronize, Activate/Deactivate, Isolate, or Replace referenced documents.
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Managing Multi-Model Links (3/4)



Student Notes:



Another way to determine the source document for a copied surface is to click Parents/Children. A dialog box displays the source document.
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If you no longer want the target document to update changes to the source, you can break the link from the contextual menu. Click Isolate to break the link between the source and target documents. New Geometrical set is created called ‘Isolated External Reference’ the Isolated element is moved in to this Geometrical set.
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Managing Multi-Model Links (4/4)



Student Notes:



When changes occur to the source document, the linked document will display a red X in its icon. This indicates that the link is not up to date. You can update the link using the links dialog box. Another way to update a link without opening the Link dialog box is using the contextual menus. To update an individual link without opening the links dialog box, right-click on the solid and click Solid.1 object > Synchronize from the contextual menu.
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To update all links in a model at the same time, right-click on the part and click Part2 object > Synchronize All from the contextual menu.
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To Sum Up



Student Notes:
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In the following slides you will find a summary of the topics covered in this lesson.
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Organizing a Surface Model



Student Notes:



Manage complex model efficiently by logical grouping of geometries, groups or sets. Model organization will help to reduce the size of the specification tree and organize it. It is easier to reorder and replace features. A geometrical set is the default container for wireframe and surface elements. An ordered geometrical Sets adds the functionality of a linear update sequence to the geometrical set. Geometrical sets maintain better flexibility. A Group is a visualization element applied on the geometrical Sets Model Organization can be performed by using following tools: Insert a Geometrical Sets Move elements of Geometrical Sets
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Ordered Geometrical Sets Create Groups
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Create the Reference Geometry



Student Notes:



Reference Geometry are the basic elements, which provide a stable support to your geometry. This reference geometry can be used to design more intricate wireframe and surface geometries. A local axis is a user-defined axis system that can be used to define local coordinates. An axis system can automatically be generated when a new part is created. This axis system is defined at the origin of the model and uses the default reference planes for direction. Curves can be used as guides, limits, or references to create other geometric elements. Surfaces inherits the flaws of the parent curve. Hence great
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care should be taken while constructing the wireframe.
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Create the Basic Surface Geometry



Student Notes:



Complex 3D shapes need to be defined using surface geometry which is created based on explicit wireframe construction geometry. Surface geometry can then be integrated into the final solid part definition. In this lesson you will the learn following operations: Creating an Extruded Surface: An extruded surface is created by extruding profiles in a specified direction. Creating a Surface of Revolution: A revolve feature is created by revolving a profile about an axis. Creating a Sphere: A sphere feature is a full or partial spherical surface. Creating a Cylinder Surface: A cylinder surface
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extrudes a circular profile in a specified direction.
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Perform Trim Operation



Student Notes:



After the basic surface geometry is created, it may be composed of construction elements that do not describe the finished shape. Operations such as trim are then performed to produce the required geometry. In this lesson you will learn following operations: Splitting Elements: Use the Split tool to remove unwanted portions of the wireframe and surface elements. Trimming Elements: Use the Trim tool to trim two or more intersecting elements and keep only a part of these elements. Replacing Elements: Use the Replace tool to substitute one element in the specification tree
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with another element using the replace command.
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Creating Multi Model Links



Student Notes:



Using multiple bodies while designing can give the model added flexibility. Boolean operations allow complex models to be created by adding, removing, or intersecting simple geometric shapes. In the context of the concurrent engineering, Multi Model links enable you to design a model using elements from another model. Many features can be reused in other documents. This reduces the time to recreate the features. You can achieve this by using available Paste Special options.
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Using Multi Model Links you can copy bodies created in different files into your own part. This enables to automatically update the part when changes occur in the source files. Paste Special: With paste special option many features can be reused in other documents. This reduces the need to recreate features that are commonly used in files and also aids in concurrent engineering.
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Generative Shape Design Tools Surfaces 1



Extrude: creates surfaces by extruding a profile



2



Revolve: creates surfaces by revolving a profile about an axis



1



Sphere: creates a full or partial spherical surface.



2



3



4



Cylinder: creates a surface by extruding a circular profile in a specified direction



Operations 5



Spilt: removes unwanted portions of wireframe and surface elements



6



Join: logically fills the gap between two surfaces



3 4
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6
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Exercise: Surface Creation



Student Notes:



Recap Exercise 20 min



In this exercise, you will open an existing model and use the tools learned in this lesson to create the wireframe and surface geometry necessary for the shell of a flashlight. To save time, simple wireframe elements have already been created for you. Detailed instructions for this exercise are provided for all new topics. By the end of this exercise you will be able to: Create a Polyline Create a Line Create a Spline
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Create a Revolve Create a Extrude Create a Trim
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Do it Yourself (1/6) 1.



Student Notes:



Load Ex7D.CATPart. • Load Ex7D.CATPart. This part already has some points and sketches created for you. a.
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b.



Observe that all the wireframe elements have been created in a separate Geometrical Set. Ensure the Wireframe Geometrical Set is active.
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Do it Yourself (2/6) 2.



Create a Revolve surface • Create a revolve surface using the polyline, spline and line provided in the start data. These surfaces would form the shells of a flashlight. a. b. c. d.



Click the Revolve icon. Select the Polyline. Select X axis as revolution axis. Specify the angle values as follows:



2a



2b



2d



2c



Angle 1 = 0deg, Angle 2 = 180deg



Click OK to complete. Repeat the operation using the spline and the line.



2e
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e. f.
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Do it Yourself (3/6) 3.



Create an Extrude. • Extrude a surface from the given curve. This extruded surface would be later trimmed with a revolved surface. a. b. c. d. e.



3a



Click the Extrude icon. Select the profile as ‘Second Sweep Guide curve’. Select the default direction (normal to the sketch plane). Specify the limit as 100mm on one side and 0mm on the another side. Click OK to complete the extrude.



3b 3c



3d
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3e
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Do it Yourself (4/6) 4.



Create an Extrude. • Extrude a surface from the given curve. This extruded surface would be later trimmed with a revolved surface. a. b. c. d. e.



4a



Click the Extrude icon. Select the profile as ‘Button Hole Sketch’. Select XY plane as extrude direction. Specify the limit as 100mm on both side. Click OK to complete the extrude.



4b 4c



4d
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4e
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Do it Yourself (5/6) 5.



Create a Trim • Create a trim between the first revolved surface and extruded surface. This would form a stepped feature on the flashlight. a. b. c. d.



Click the Trim icon. Select the first revolved surface. Select the first extruded surface. Select other side if required.



e.



Click OK.



5a



5b 5c
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5d



Copyright DASSAULT SYSTEMES



5e



7-105



CATIA V5 Automotive - Body Lesson 7: Create Simple Surfaces Student Notes:



Do it Yourself (6/6) 6.



Create a Trim • Create a trim between the last revolved surface and the second extruded surface. This would form a stepped feature on the flashlight. a. b. c. d.



Click the Trim icon. Select the last revolved surface. Select the second extruded surface. Select other side if required.



e.



Click OK.



6a



6b 6c
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6d
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Exercise Recap: Surface Creation



Student Notes:



Create a Polyline Create a Line Create a Spline Create a Revolve Create a Extrude
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Create a Trim
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Exercise: Surface Creation



Student Notes:



Recap Exercise 20 min



In this exercise, you will create a new model using pre-defined features. You will practice the stacking commands and the tools learnt in the previous step. High-level instructions for this exercise are provided. By the end of this exercise you will be able to: Create a Cylinder Create a Sphere Create a Point on a surface
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Create a Trim
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CATIA V5 Automotive - Body Lesson 7: Create Simple Surfaces Student Notes:



Do it Yourself (1/3) 1.



Create a new part file (Ex7E.CATPart) in Generative Shape Design Workbench.



2.



Create a Cylinder. • You will contextually create the inputs required for a cylinder from Cylinder Surface Definition dialog box. a. b.



c. d.



2c



Select the Cylinder icon. Specify the parameters as follows: • Radius = 30mm • Length 1 = 50mm • Length 2 = 50mm Create a point contextually on absolute co-ordinate system. Specify the Direction as X axis contextually. Click OK to create a Cylinder.
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e.



2a
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2d 2e
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Do it Yourself (2/3) 3.



Create a Sphere. • You will contextually create the inputs required for a sphere from the Sphere Surface Definition dialog box. a. b. c.



d. e. f.



3a



Click the Sphere icon. Specify the full sphere icon Right-click on the center selection field and create a point contextually at the following given co-ordinates: • X =10mm, Y=25mm, Z=0mm Specify the default Sphere axis. Specify the Sphere radius as 20mm Click OK to create the Sphere.



3c



3b



3d
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3e
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Do it Yourself (3/3) Create a Trim Create a trim between a Cylinder and a Sphere to get the shown result.



5.



Close the file without saving it.
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4.



Student Notes:
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Exercise Recap: Surface Creation



Student Notes:



Create a Cylinder Create a Sphere Create a Point on a surface
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Create a Trim
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CATIA V5 Automotive - Body Lesson 7: Create Simple Surfaces



Exercise: Surface Analysis and Modification



Student Notes:



Recap Exercise 20 min



In this exercise, you will open an existing model and use the tools learned in this lesson. You will use the feature management tools to re-organize the tree structure and make it simpler to use. To start with, you will study and understand the specification tree structure of the given ‘Tunnel’ part. You will also edit the height of the lower flange in the model by changing the required parameters of the surface. By the end of this exercise you will be able to: Analyze the Tunnel construction
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Modify the Lower flange Height
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Do it Yourself (1/9) 1.



Load Ex7F.CATPart • Load Ex7F.CATPart. This part already has the surface model of a tunnel. 2b



a. Overview the structure of the specification tree. b. Think of ways to simplify the tree structure. 2a
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2.



Search a feature in the model • Search for a surface called ‘Support face’ (Join feature). Later you will study the Parents/Children relations of this feature a. Click Edit > Search. b. Type the text *support face* in name text box. c. Click the Search button. You will find the list of objects with the name ‘support face’. d. Right-click the object you want to see and select Center Graph in the contextual menu to view it in the specification tree. e. Click OK to complete the search.
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2c



2d



2e
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Do it Yourself (2/9) 3. Analyze the construction architecture of the ‘Support Face’ • Study the Parents/Children relations of the feature.



3a
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a. Select the Quick Select icon. b. Select the join feature ‘Support Face’. A Quick Select dialog box opens. You can see the parent and children of the selected feature. c. Click on the parent feature to understand Edge fillet.14 the hierarchy of the operations. Sequentially, go on clicking on the parent feature in the dialog box to understand the construction architecture of the support Trim.5 face feature. d. Click OK to end the analysis.
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Support Face (Join)



3b



Split.2



3c 3d
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Do it Yourself (3/9) 4.



Organize the features • Create subsets for wireframe and surface features inside ‘STAMP_SIDE_WALL’ Geometrical Set. a. Click Insert > Geometrical Set b. Name the new set as ‘Side wall Wireframe’. Select ‘STAMP SIDE WALL’ as father. c. Click OK to create geometrical set d. Select the wireframe features to be moved into ‘Side wall Wireframe’ geometrical set (shown). e. Select Change geometrical set from the contextual menu. f. Select the destination Geometrical Set as ‘Side wall Wireframe’. g. Click OK to move the features.



4b



4c



4d



4e
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Do it Yourself (4/9) 5.



Organize the features • Repeat the previous step (Step 4) to move the surface features into different geometrical set. a. Click Insert > Geometrical Set



5b



b. Name the new set as ‘Side wall surface’.



Select ‘STAMP SIDE WALL’ as father. c. Click OK to create geometrical set



d. Select the surface features to be moved into ‘Side wall surface’ Geometrical Set (shown). e. Select Change Geometrical set from the contextual menu. f. Select the destination geometrical set as ‘Side wall surface’. g. Click OK to move the features.



5c



5d 5e
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Do it Yourself (5/9) 6.



Create Groups • Create an individual group of the sets created in the previous steps. a. b.



7.



c.



6a



Create Groups • Repeat the previous step (step 6). Create a group from geometrical set ‘Side wall surface’ a. b.



c.
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Select the ‘Side wall Wireframe’ set. Right-click on the selection and through the contextual menu select Create Group. Click OK to create a group.



6b



Select the ‘Side wall surface’ set. Right-click on the selection and through the contextual menu select Create Group. Click OK to create a group.



7a
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7c 7b
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Do it Yourself (6/9) 8.



Reopen the group to check the contents • Expand the group to check the contents. a. b.



c.
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d.



Select the ‘Group-Side wall wireframe’. Right-click on the selection and through 8a the contextual menu select Expand Group. The group gets expanded. You can visualize the contents of the group. After checking the contents, right-click on the group and through contextual menu, select Collapse Group.
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8b Collapse Group



8d Expand Group
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Do it Yourself (7/9) 9.



Modify Tunnel’s lower flange height • Analyze the creation sequence of the model to identify the height parameters. a. Click on the Only Current Body icon. b. c. d.



Define in work object the Geometric Set ‘STAMPED FORM’. Expand ‘STAMP LOWER FACE’ set. Analyze the Parents/Children relation of ‘STAMP_LOWER_FACE’ surface (join feature).



9a 9b



9c



Copyright DASSAULT SYSTEMES
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Do it Yourself (8/9) 9.



Student Notes:



Modify Tunnel’s lower flange height (Continued) e.



Double-click on the parent features until the initial parent feature is visible in the Parent/Children tree.



Copyright DASSAULT SYSTEMES



9e
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Do it Yourself (9/9) 10. Modify the offset clearance Parameter a. Right-click on the OFFSET_CLEARANCE. b. Using the contextual menu, select Edit. c. In Offset Surface Definition dialog box, modify the offset parameter from 0.6mm to 8mm. d. Click OK to modify the value. e. Select the Only Current Body Icon to visualize the entire model. 11. Close the file without saving it



10a



10b



10c
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Exercise Recap: Surface Analysis and Modification



Student Notes:



Analyze the Tunnel construction
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Modify the lower flange Height



Before reorganization
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After reorganization
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Case Study: Create Simple Surfaces Recap Exercise 10 min



In this exercise, you will modify the case study model. Recall the design intent of this model: The model must be organized in geometrical sets. The speaker opening diameter (A) must be 100mm. The depth (B) of all the four speaker mountings must be 3mm.
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The resulting surface must be in a separate geometrical set.



Using the techniques you have learnt so far, create the model without detailed instruction.
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A B
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Do It Yourself: Create the Simplified Inner Door



Student Notes:
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Modify the CaseStudy7.CATPart using the drawing provided here.
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Case Study Recap: Simplified Inner Door



Student Notes:



Organize the model Create an extrude surface Split the surfaces Create reference geometry
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Trim the surface
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